
READ ME FIRST! 

ELECTRONIC ARTS PRESENTS 

CD-ROM CLASSICS 
ULTIMA® UNDERWORLD™ I & II 

EPILEPSY WARNING 
PLEASE READ BEFORE USING THIS GAME OR ALLOWING YOUR 
CHILDREN TO USE IT. 
Some people are suscepLible to epileptic seizures or loss or consciousness when exposed to cerlain 
flashing lights or lighL panems in everyday lire. Such people may have a seizure while waLching 
television images or playing certain games. This may happen even ir the person has no medical hisLory 
of epilepsy or has never had any epileptic seizures. 
If you or anyone in your family has ever had symptoms related to epilepsy (>eizures or loss of 
consciousness) when exposed LO flashing lights, consult your doctor prior to playing. 
We advise Lhat parents should monitor the use of games by thei r children. If you or your child 
expelience any or Lhe following symptoms: dizziness, blurred vision, eye or muscle Lwitches, loss of 
consciousness, disorientation, any involuntary movement or convulsion, while playing the game, 
IMMEDIATELY discominue use and consult you r doctor. 

PRECAUTIONS TO TAKE DURING USE 

Do not stand too close to the screen. Sit a good distance away from the screen, as far 
away as the length of the cable allows. 

Preferably play the game on a small screen. 

Avoid playing if you are tired or have not had much sleep. 

Make sme that the room in which you are playing is well lit . 

Rest for at least 10 to l 5 minutes per hour while playing a game. 



This document contains all the information that you will 
need to get this game up and running. There are 
important sections covering how to produce the necessary 
boot disk, how to install and run your game, a full key 
guide and instructions on how to use the Adobe Acrobat 
on-line document reader. 

For further information, the original manuals are 
provided "on-line" on the CD. These can be read using 
the included Adobe Acrobat on-line document reader. To 
use this, see the section "Using the On-Line 
Documentation" 

• 
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TO VIEW THE ORIGIN ON-LINE CATALOG: 

1. 

2. 

3. 

4. 

Insert the CD in your CD drive and start Windows 

From the Windows Program Manager, choose RUN .. .from the File menu. The Run dialog box appears. 

Type d:\catalog.exe. (If youc CD-ROM isn't drive D:, substiture the appropriate letter for "d".) 

Click OK or press ll ENTER i and follow the instructions on your screen. 

Note: Windows must be running in 256 color mode to view the catalog correctly. Consult 
your video card manual for more information. 

The system requirements and procedure for starting and playing Ultima Undel'wodd I & II are listed 
below. Please refer ro the on-line documentation for all ocher gameplay information (see UJing the 
On-Line Documentation below) 

System Requirements 
Computer. These games call for an IBM-PC 386SX or higher or a 100% compatible system. 

Video Card. An IBM VGA or compatible video card with at least 256K of video ram is required. 
(Note: MCGA, as found on the PS/2 model 25 and model 30, will not work.) 

Free RAM. You must have at least 640K of base RAM (memory) to play Ultima Underworld or 
Underworld II. Of the 640K, at least 527,360 bytes (UWl) or 544,768 byres (UW2) of base 
memory must be available at the DOS prompt to run the minimum game configuration. other 
configurations may need as much as 566,272 bytes free RAM (UWl or 581,632 bytes free RAM 
(UW2). See Memory Requirements for more information. 

EMS. To play either Underworld game, you must configure your computer to make use of expanded 
memory. The amount varies: 

UWl : In addition to 515-533K of free base RAM, you will need at leas t 480K (491 ,5 20 bytes) of 
expanded memory available at the DOS prompt. UWl won't run with Jess than that. 

UW2 : In addition to 532-568K of free base RAM, you must have at least 656K (671,744 bytes) of 
expanded memory available at the DOS prompt. UW2 won't run with less than that. See Memory 
Requirements and Optimizing Your System for more information. 

Hard Disk. You must have a minimum of 2 free megabytes on your hard disk to install and play 
either or both games from the CD. 

CD-ROM. MS-DOS CD-ROM extensions 2.1 or higher are required; a CD drive with 350 ms or 
faster seek time is recommended. 
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Installation 
ORIGIN does not support the use of disk compression utilities wirh these games. the use of disk 
compression utilities might cause them to be unplayable from your CD-ROM drive. 

The following instructions apply to both games - Underworld (UWI) and Underworld II (UW2) -
unless specifically stated otherwise. 

The Reference Cards begin with instructions for beginning play if the game you are about to play is 
installed on your hard disk. If you are playing form the CD, follow the instructions in Installation. 
Step 9 (below), instead. 

NOTE: It is possible to play both games directly form the CD, but it is necessary to copy 
some files to your hard disk and to create directory for your saved games first . See 
Troubleshooting for instructions on how to copy the entire game to you hard disk, 
should you choose to do so . 

Each game must be installed individually. However, you can install one game now and the second 
game at another time or both games now, one after the other. 

While selecting options, you can press 1001 at any time to return to DOS. This aborts the 
installation process. 

When appropriate, use [Jl] and rn to highlight the option you want. Press II ENTER I to select a 
highlighted option. 

I. Insert the CD-ROM disk (label side up) into your CD-ROM drive. (Some drives may require 
that you put the disk into a CD caddy before inserting it in the drive itself.) 

2. Change to your CD-ROM drive by typing its drive letter followed by a colon (e.g., D:) and 
pressing Enter. 

3. Type origin and press II ENTER iji to begin installation for Ultima Underworld I. After installation 
is complete, you will be prompted to install Ultima Undenvorld II. 

4. The program will list all hard drives to which you may install. The program will then prompt you 
for the letter of the hard drive to which you want you sysrem configuration data and saved games 
written. Press the letter on your keyboard corresponding to a hard disk with adequate space. 



5. 

6. 

7. 

8. 

9. 

The next configuration option is Sound System Installation. This determines how music and 
sound effect will play during the game. Your choices are: 

No Sound PC Speaker (UWl only) 
Ad lib Sounc!Blasrer 
Sound Blaster Pro Roland MT-32 or LAPC-1 

Highlight rhe sound board you have (or no sound or PC Speaker (UWl only) if you don't have 
a sound board) and press II ENTER 11- If you chose Roland MT-32 or LAPC-1, ir will ask if you 
have a sound Blaster or SoundBlasrer Pro ro use for digitized speech. 

If you choose Sound Blaster or Sound Blaster Pro in Step 5 (either originally or after selecting 
Roland), you will have to tell the installation program the "Base IO" and "IRQ" setting for you 
sound card. If you have a Sound Blaster Pro, you will also need to know that DMA channel it 
uses. For example, rhe factory default settings are Base IO: 220H, IRQ 7 and OMA channel 
1. (Some were Sound Blas ter models default to IRQ 5.) Use (up) and (down) t0 highlight each 
appropriate selection, then press II ENTER ij . 

After you have chose your sound card, you will be shown your current settings. If the 
configuration is correct, select 00 to continue. If it is incorrect, select llliJJ. If you seleet ~' 
yo.'.. begin again at Step 4. 

When the Confirm Selections screen appears, you must decide if you want to copy the 
necessary files to you hard disk. If the configuration is correct, press m to continue. 

If the configuration is incorrect, press ~· You can now begin again from the drive selection 
screen (Step 4). 

After you select [J], the installation program will write the configuration information to your 
hard disk and prepare it to receive saved games. This process takes only a few seconds; almost 
all information is kept on the CD-ROM. 

When the installation is complete, you automatically return to the prompt of your CD-ROM 
drive. You can now play either game you have installed. 
UWl: To play Underworld, type UW at rhe CD-ROM prompt. 
UW2: To play Underworld II, type UW2 at the CD-ROM prompt. 
(In the future, when you want to play either game, just repeat Steps 1,2 and 9.) 

10. If you have never played Underworld or Underworld II before, consult rhe appropriate Player's 
Guide. Each guide begins with a tutorial and explains everything you need ro know ro start 
playing the game. If you encounter any difficulties, check Troubleshooting in this Install Guide. 
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Changing Your Configuration 
If you ever add a sound card or change from one card ro another, simply re-run the installation 
program as described above. 

Using the On-Line Documentation 
DOS USERS: 

To install the D OS Adobe Acrobat on-line d ocument read er: 

N OTE: If you have Microsoft® Windows" installed, we recommend that you install the 
Windows version of the Adobe Acrobat reader for greater ease of us'e when reading 
the on-line manuals. See below for instructions on installing Acrobat for Windows. 

N OTE: If you have already installed the Acrobat reader from another CD-ROM C!assiCJ tide, it 
does not need to be re-ins talled- skip to the To Start Adobe Acrobat for DOS or To Start 
Adobe Acrobat for \Vindows section. 

1. Insert the CD in your CD drive. 

2. Type ~ (or the letter of your CD drive, if different) and press II ENTER i t0 move t0 the CD drive. 

3. When you see the "D:" prompt, rype [[gl]00[IJ~[IJ[ID and press ll ENTER i . 

4. You are asked whether you want ro insrall Ultima Underworld l and then Ulti111a U11derworld ll. 

5. 

If you have already done this, press ~ to skip the U11derworld insrallarion and go to the 
Acrobat Reader installation. 

You are asked whether you want to install The Acrobat Reader for DOS. Press iJ] to install or 
[lliJ to stop installation. Follow the menu prompts to install the on-line documentation reader. 

To. highlight a menu item, press the arrow cursor keys [U/[i]. 
To activate the highlighted item, press ~. 
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System requirements for DOS: 

386- or 486-based PC (486 recommended), DOS 3.3 or higher 
2 MB of available RAM (4 MB or more recommended) 
4 MB hard disk space 
Microsoft-compatible mouse 

VGA graphics 
Postscript or LaserJet printer supported 

To start Adobe Acrobat for DOS: 

1. The CD muse be in che drive to run the program. 

2. Move to the directory where Adobe Acrobat is installed. By default, it is installed in 
C:\ACRODOS, so you would type: 

[£JJQ llENTER J[ 

cd\acrodos II ENTER II 
3. Type acrobat II ENTER I co start the program. 

NOTE: If you receive an ''.ACROBAT.IN!" error message when running Acrobat, see Cnating a 
Boot Disk below. 

To open an on-line document file: 

Select Open from the File menu. (The on-line documents are located on che CD-ROM Ckmia CD.) 

Double-dick on che [gJQ (or appropriate CD drive letter) from the DRIVE dialog box. 

Double-dick on the language you require or select MAPS. 

Double-dick on an on-line documentation fJe co open it. The file(s) are: 

MANUALl.PDF Ulti111a Underworld Manual, Memoirs of Cabirus 

UWIPLAY.PDF 

MANUAL2.PDF 

UWIIPLAY.PDF 

MAPS 
UWlMAP.PDF 

UW2MAP.PDF 

Ultima Underworld Player's Guide 

Ultima Underworld II Manual, A Safe Passage Thtough Britannia 

Ulti111a Undenvorld II Player's Guide 

Ulti111a Underworld Map, The Stygian Abyss Map 

Ulti111a Underworld II Map, Labyrinth of Worlds 
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WINDOWS USERS: 
System requirements for Windows: 

386-or 486-based PC (486 recommended) 

4 MB RAM 

Microsoft Windows 3.1 or greater 

To install Adobe Acrobat for Windows: 

1. Insert the CD in your CD drive. The CD muse be in the drive co install and run the program. 

2. Scare Windows. 

3. From the Windows Program Manager, choose RUN ... from the File menu. The Run dialog box appears. 

4. Type d:\adobe\acrowin\acroread.exe 

(If your CD-ROM isn't drive D: , substitute the appropriate letter for 'd' .) 

5. Click OK or press Ii ENTER II and follow che instructions on your screen. 

To start Adobe Acrobat for Windows: 

1. Start Windows and ensure rhac the CD is in the drive. 

2. If the Acrobat Reader 2.0 icon is not visible in che Program Manager window, double-click on 
the Acrobat ptogram group icon. The Acrobat window opens. 

3. Double-dick the Acrobat Reader 2.0 icon. The program begins. 

To open an on-line document file: 

Select Open from the File menu. (The on-line documents are located on the CD-ROM C!aJSics CD.) 

Double-dick on che ![ruQ (or appropriate CD drive letter) from the DRIVE dialog box. 

Double-dick on the language you require or select MAPS. 

Double-dick on an on-line documentation file co open it. The file(s) are: 

MANUALl.PDF Ultima Undenvorld Manual, Memoirs of Cabirus 

UWIPLAY.PDF 

MANUAL2 .PDF 

UWIIPLAY.PDF 

MAPS 
UWlMAP.PDF 

UW2MAP.PDF 

Ulti111a Undenvorld Player's Guide 

Ultima Underworld II Manual, A Safe Passage Through Britannia 

Ulti111a Underworld II Player's Guide 

Ultima Undenvorld Map, The Stygian Abyss Map 

Ultima Underworld II Map, Labyrinth of Worlds 
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To print a document file : 

Select PRINT from the File menu. Choose the range you want to prim from the Prim Range 
dialog box. 

If you receive a "Acrobat does nor support printing at this device resolution ... " message, 
increase the resolution in the Print Quality dialog box. 

In DOS, prior to priming, go into PRINT SETUP from the File menu. Choose Bitmap, which 
will ptovide a list of available printer devices. 

The Adobe Acrobat Document Reader does not support 9-pin primers. 

To learn how to use Adobe Acrobat: 

Open the file HELPREAD.PDF in the C:\ ACRODOS directory on your hard drive. Complete 
Acrobat instructions are contained in this file. 

Quick Acrobat Tips: 

If you have difficulty viewing documenrs, click on the magnifying glass icon on the bortom of 
the screen to increase resolution. 

Each document file contains bookmarks that function as an electronic table of contents. To 
view bookmarks, select Bookmarks and Page from the View menu. The bookmarks appear to 
the left of the document window. 

To jump to the page associated with a bookmark, double-dick on the page icon next to the bookmark. 

To show or hide any subordinate bookmarks, click the triangle to the left of bookmark. 

To move through the document one page at a time click the Previous or Next Page buttons or 
press the [B/IEJ cursor keys. 

To move through a document one screen at a time, dick above or below the scroll box in the 
scroll bar or press the m~ keys . 
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Troubleshooting 
Memory Requirements 
There are three types of RAM referred to in this manual: DOS (conventional base RAM), extended 
and expanded. UWl and UW2 have specific minimum requirements for each of these types of 
memory. if you are unsure about these differem types of memory, consult your DOS manual. 
To find out how much DOS, extended and expanded memory your computer has available, type EM 
at the DOS prompt. When the memory information is printed on the screen , look for the following 
listings: 

Largest Executable Program Size (This number indicates how much DOS memory is available.) 

Total Extended or XMS or Total Contiguous Extended (this is the amount of extended 
memory in your computer.) 

Bytes Free of EMS or Free Expanded (EMS) (This is the amount of expanded memory 
available to the program.) 

If any of the numbers listed on your screen are less than the requirements listed below, refer to 

Optimizing Your System (page 9) . 

Ulcima Underworld I Memory Requirements 

Type of memory Minimum requirements to 
run game without sound 
effects, music, or speech 

DOS (Conventional) 
Base RAM 527 ,360 bytes 

*Extended 1,024,000 bytes 
Expanded 492,000 bytes 

Minimum requirements to 

run game with Internal 
(PC) speaker 
(sound effects only) 

535,360 bytes 
1,024,000 byres 
492,000 bytes 
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Minimum requirements 
to run game with 
speech, music and 
sound effects (sound card) 

565 ,248 
1,024,000 bytes 
492,000 bytes 



Ultima Underworld II Memory Requirements 

Type of memory 

DOS (Conventional) 
Base RAM 

*Extended 
Expanded 

Minimum requirement co run game 
without sound effects, music, 
or speech 

544, 7 68 byres 
1,024,000 bytes 
671,744 bytes 

Minimum requiremeacs to run game 
wirh speech, music and sound 
effect (sound card only) 

544,768 bytes 
1,024,000 bytes 
671 ,744 bytes 

*You muse have a total of 1,024,000 bytes of extended memory on your computer to run eitber or 
both of these games. However, chis memory muse be converted to expanded memory by using an 
expanded memory manager in your CONFIG.SYS file. The two most common expanded memory 
managers are Quarterdeck's QEMM386.SYS or Microsoft 's EMM386.EXE (available in Microsoft 
DOS 5.0 or higher, or Microsoft Windows 3.1) If you are unsure how to load the expanded memory 
manager from DOS, refer to Optimizing Yottr System. For assistance with QEMM, consult your 
documentation. 

Optimizing Your System 
If you are experiencing problems running the Underworld/Underworld II CD-ROM games, it might 
help to create a separate boot disk or decrease the number memory-resident programs (TSRs) you 
have loaded with the suggested configurations listed below. 

Do not delete your AUTOEXEC.BAT or CONFIG.SYS files completely - without chem, your 
computer will not function . 

Before creating a boot disk, we recommend that you generate a hard copy printout of your hard 
drive CONFIG.SYS and AUTOEXEC.BAT start-up files. To do so, at the DOS prompt, type: 

cype config.sys 
Use the PRINT SCREEN key to generate a printout of chis startup file. At the DOS prompt, type: 
type autoexec.bat 
Use the PRINT SCREEN key to generate a printout of chis startup file . 
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Creating a Boot Disk 
To create a separate ~oot disk, insert a blank high density disk in your A: drive. From the DOS 
prompt, type: 

format a:/s II ENTER ! 

Modifying CONFlG.SYS 

When the DOS prompt returns and the format is complete, type: 
edit a:\config.sys II ENTER I 

W hen the new screen appears, type the commands shown below. This configuration is generic and 
may require additional drivers. Consult your CD-ROM manual and printouts for more information. 

CONFlG.SYS 11si11g DOS's EMM386.EXE 
Files =20 
Buffers =20 
Device=C:\DOS\HIMEM.SYS 
Device=C:\DOSIEMM386.EXE 1024 RAM 
DOS=UMB 
DOS= HIGH 
SHEll= C:\DOS\COMMAND.COM /P 
DEVICEHIGH=C:\<path>\CDROM driver <all parameters from the original config.sys> 
(Refer to your hard drive CONFIG.SYS printout to fill in the blanks in the last line above.) 

After Typing the CONFlG.SYS Co111111a11ds 

ACROBAT NOTE: If yo111:eceive any "affobat.ini" error messages from the DOS Ac.-obat domment 
reader program, add or modify the following lines to the config.sys file 011 yo11r boot disk: 

FILES=30 

BUPFERS=30 

After typing these lines, you should exit and save your file. Do so by pressing: 

~[[! 
10 
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Next you need an AUTOEXEC.BAT file on your boot disk. Type: 
EDIT A:\AUTOEXEC.BAT JI ENTER II 
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When the new screen appears, type: 
PROMPT $P$G 
PATH=C:\DOS 
C: 
C:\<path>\mscdex.exe <all parameters from the original AUTOEXEC. BAT with the 
following exceptions> 

delete the /E parameter 
Change/M: :## to /M:5 

LH C:\MOUSE\MOUSE.COM 
(Your mouse driver may need to be loaded differently. Refer to the printout of your 
original AUTOEXEC.BAT.) 

Exit and save this file by pressing: 

llfil![IJ 
~ 
[I! 

To Use Your New Boot Disk 

1. Turn your computer off, insert your new boot disk in you A drive and turn the computer back 

on. (If your CD drive is external, turn it on.) 

2. Insert the CD-ROM disk (label side up) into your CD-ROM drive. (Some drives may require 
that you put the disk into a CD caddy before inserting it in the dtive itself) 

3. Change to your CD-ROM drive by typing its drive letter followed by a colon (e.g., D:) and 
pressing Enter. 

4. UWl: To begin playing Underworld, type: UW jlENTE Rll 

UW2: To begin playing Underworld 11, type: UW2 jlENTER ij 

Troubleshooting 
Q: Underworld or Underworld II fails to load or run and generates an error code. What's wrong 
with my game? 

A: Certain error codes can easily be interpreted and remedied: 

A### (i.e. and "K followed by three numbers) usually means a low file count. 

Your CONFIG.SYS file may need to be modified. If you get a message that reads "Internal 
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Error" or "Underworld can no longer run. Error code A###," edit your CONFIG.SYS file so 
the line reading "FILES=##" reads "FILES=20" (or more). This should allow you to play the 
game. (Consult Optimizing Your System (above).) 

B### means low conventional (base) memory. 

Run the MEM program included with DOS to check your computer's available RAM. To do 
this, type MEM after the prompt for the drive in which you have installed the game. consult 
the "Largest executable program size" line. UWl requires 565,248 byres for all options and 
UW2 requires 581,632 bytes for all options. Free up RAM if needed or make a new floppy 
boot disk. (consult Optimizing your System (above).) 

C### means a problem with expanded (EMS) memory. 

You may be using a non-compatible memory manager. UW1/UW2 requires a LIM4.0 EMS or 
100% compatible driver. Compatible memory manager; include DOS's EMM386.EXE and 
QEMM386.SYS. This error may also indicate that you do not have enough expanded memory 
allocated to run this game. Consult Memory Requirements and Optimizing Your Sysrem (above). 

E### means that you do not have enough hard disk space. You must have at least 2 megs free 
on you hard disk to install and play either game, even if you are playing it directly from the CD. 

You may have chosen an invalid configuration during the install process. Check your 
configuration and if necessary, re-install the game. 

You may have filled all free space on the active hard drive. Use the DOS DIR command to check 
available hard drive space. You need at least 2 megabytes for saved games and temporary files. 

Q: My mouse is not working with UW/UW2 CD-ROM. My mouse works with all of my other 
software applications - why not with UW/UW2? 

A: If your mouse is not working with UW /UW2, you should first check to see if your mouse has been 
loaded in DOS (in your AUTOEXEC.BAT file) or onto the boot disk you are using to play the game. 
Windows and many other "multitasking" environment load their own built-in mouse driver. These 
mouse drivers will not operate ourside of their shell environmenr. Loading a mouse driver into the 
DOS environment can be as simple as typing MOUSE !I ENTER 11 at the command prompt. For 
example, 

C:\MOUSE jlENTER ij 

This command can differ depending on which mouse driver software you are using . Please consult 
your mouse user's guide for £\irther derails . 
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Some rare combinations of hardware and software cause mouse conflicts that freeze the on-screen 
pointer. If you mouse pointer ever stops moving, press [!k!lj~ to free the mouse and allow the 
pointer to move normally, or get a Microsoft mouse driver version 7 .0 or higher. 

Q: When I try to run the game, I get a message that says "Sound System Initialization Failed." 

A: You probably have enough memory to run the game, but not enough to load the sound drivers 
you selected during installation. You will either have to increase the amount of free DOS memory 
(see Optimizing Your System) or play without sound. 

or If your sound card is not one of the cards listed on the box or in the installation program, but is 
100% compatible with one of the cards listed, it may need robe configured for Sound Blaster 
emulation mode. Consult your sound card manual. 

Q: (UWI only) When I select PC Speaker sound effects all I get are "Beeps" and "Boops". 

A: There's nothing wrong with your speaker or your game. The PC speaker sound effects are not 
intended to be realistic. They do, however, provide important feedback (whether you hit a crearure 
in combat, for example.) The best answer is to upgrade your system with a sound card. (The 
installation menu lists the cards supported by Underworld.) If a system upgrade is impossible and 
you would rather pay without sound, select the OPTIONS icon from the main game screen, 
followed by the SOUND option. Turn the sound off and return ro the game. 

Q: Is it possible to play different characters in different games? 

A: Each game allows you ro save up to four different games at once. For each game, you can save 
four different points in a single adventure . You can also save one character's adventure in the first 
saved game slot, another character's adventure in the second slot and so on. Any combination of 
characters and saved game slots is possible (up to the maximum of four per game). Note that you 
cannot transfer a UWl character into UW2, or vice versa. 

Q: The game runs too slowly. 

A: Your computer may not be fast enough to run the game efficiently. The minimum configuration is a 
386SX with a 16 MHz processor - but movement and animation are faster and smoother on a faster 
computer. From the main game screen, select the OPTIONS icon, followed by DETAIL. Exp,,.iment 
with the various detail levels until you find a balance between speed and detail that suits you. 

Q: I've tried to save my game, bur I keep getting a message that says "SAVED GAME FAILED." 

A: Each saved game can take up to 500K of hard disk space. If you don't have that much available, 
you can't save. To get around this, you can save your new position over an existing saved game. Select 
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the OPTIONS icon from the main game screen, followed by the SAVE GAME option. Then, simply 
select a saved game slot you've already used. When you are asked to enter a name from the game, 
press Enter to use the same name as the old game, or type in a new one. In addition, you must have 
700K (UWl) or 1200K (UW2) of free hard disk space available when you begin a mission. 

Q: When I start, the music sounds very odd on my Sound Blaster Pro. 

A: Early versions of the Sound Blaster Pro require different configurations than later versions. To 
correct this, run the SET-ENV program that came with your Sound Blaster Pro. this will 
automatically set the environment variable properly. If this doesn't work, this variable can be set 
manually. Consult your Sound Blaster Pro docs or your hardware dealer for more information. 

Q: (UW2 only) I am having trouble using my joystick. 

A: Your joystick may be set to "auto fire". If this is the case, you have difficulty moving your 
character and the buttons may not function as you expect. To correct the problem, turn auto fire off 
if your joystick doesn't allow you to turn auto fire off, unplug it and play with a mouse or use the 
keyboard controls. 

Q: (UW2 only) I seem to spin around even when I am not touching the mouse, jo)-'stick or keyboard 
movement keys. 

A: This can be caused by a miscalibrated joystick. Press iCTRL!IQJ and follow the instructions on 
screen to calibrate and center your joystick. If you cannot get the joystick correctly calibrated, you 
will have ro unplug it and play with the mouse or the keyboard controls. 

Q: Why does my computer crash when I tty to play UW/UW2 through Microsoft Windows (or 
OS/2, Desqview or DOS 5.0 Task Swapper)? 

A: "Multi-tasking environments" - windows, Desqview, Software Carousel, DOS 5.0 Task Swapper 
and so forth - often conflict in their use of memory and other system resources with UW /UW2 
CD-ROM. We do not recommend playing UW/UW2 under these circumstances". Even if you do run 
the game under a multi-tasker, do not swap to another application while playing. Your system will 
crash if you try to suspend UW /UW2 to run another program. In general, we recommend that you 
log out of Windows (or similar applications) and play from the DOS prompt. 

Q: My CD drive is too slow to play the game from. Can I play either game from my hard drive? 

A: To copy the CD version of Underworld onto your hard drive, follow these steps: 

1. Make sure you have ar least 13 megabytes of hard drive space available. 
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2. 

3. 

Type XCOPY D:\UW C:\UW /E/S iENTER j. This will copy all of the necessary files co a \UW 
directory on your hard drive. (This assumes your CD drive is D: and your hard drive is C: - if 
noc, substitute the appropriate drive letter in the above entry.) 

When che files have finished copying, change co your newly created C:\UW direcrory and type 
UINSTALL ~-This will begin che Underworld configuration process. (For UWl only, at 
the option for SELECTING CUT SCENES STATIC OR ANIMATING, select ANIMATING. 
STATIC will not work .) 

4. After completing che configuration, type UW Ii ENTER I co begin playing. 

To copy the CD version of Underworld II onto your hard drive, follow these steps: 

1. Make sure you have at least 13 megabytes of hard drive space available. 

2. 

3. 

Type XCOPY D:\UW2 C:\UW2 IE IS Ii ENTER!. This will copy of all of the necessary files co a 
\UW2 directory on your hard drive. (This assumes your CD drive is D: and your hard drive is 
C: - if not, subscicuce the appropriate drive letter in the above entry.) 

When the files have finished copying, change to your newly created C:\UW2 directory and 
rype UINSTALL !ENTER!. This will begin the Underworld II configuration process. 

4. After completing the configuration, type UW2 II ENTER ~ to begin playing. 

Note: The install program will ask if you want co delete or leave extra sound files if you are 
running without digitized speech or with no sound. You can delete these files co save space, buc 
(contrary co what che install program says) you will not be able co add them later without 
recopying the game ro your hard drive. 

Q: My Sound Blaster beeps before playing digital effects. 

A: Under OS/2 old Sound Blaster ROM (1.5) will cause this . Reinstalling without digital effects will 
fix this, though you will lose digital effects. We recommend operating under a DOS 5.0 or higher 
environment . 
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The Stygian Abyss Reference Card 
BEGINNING PLAY 
Install the game, following the directions above. Change co the CD-ROM drive and type 00~ 
II ENTER ! to begin play. If you used our default selections you would type: 

. II ENTER ! 
II ENTER I 

The first time you play: ryping 00~ takes you co the title screens, followed by the introduction. 
Press iMI to bypass the titles and/or introduction and go tn the Main Menu. 
If you have played (and saved) the game, typing 00~ takes you co the Main Menu. 

MAIN MENU 
To select an option with the mouse, click on it . With the keyboard, use the arrow keys co highlight 
it, then press ii ENTER I to select it. 

Create Character. Choose before you begin a new game. Use the mouse or arrow keys and follow 
the directions on-screen co make selections. 

Introduction. Allows you ro watch the introduction. (Press iOO co exit at any time.) 

Acknowledgement~. Lists the people who created ULTIMA Underworld. 

J ourney O nward. If you have saved games, a list appears when you select Journey Onward. Move 
the pointer to the game you wish to play and click either button. (With the keyboard, use the arrow 
keys co highlight your choice and press ii ENTER p 
MAIN GAME SCREEN 
When you Journey Onward , the main game screen appears. 

3-D View W indow. The view window shows what you see: 

• As you move, the view changes to reflect your new position. 

When you cake damage in combat, the window shakes. 

When you are critically wounded, che screen flashes red. 

• When you are drowning, the screen flashes blue. 

Normally, you look scraighc ahead, but you can look up and down: 

To look down, press [[) repeatedly. 
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• To look up, press laJ repearedly. 
To return to the "straight ahead" position, press rn. 

Character Panel. Three panels share this position, and you can switch from one to the other at will. 
The inventory panel shows all items you are carrying and wearing. From the inventory panel: 

Left-click the runebag in your inventory to flip to rhe rune display. 
Click on rhe pull chain to flip ro the statistics panel. 

• The sratistics panel displays derailed information about your character's skills and current 
condition. Click on the pull chain to return to the inventory panel. 
Your rune display shows all of the runes you own. Click on the pull chain tO rerurn to the 
inventory panel. 

On these panels, the right mouse-button triggers the action specified by the command icon selected; 
the left button selects, moves or uses an object. 

Vitality and Mana Flasks. Shows your current Vitality or Mana as compared to your maximums. If 
the Vitality flask is green, you are poisoned. 

Rune Shelf. Click on runes in your rune display and they appear here. Click on a rune here to cast 
the spell represented by the runes on the shelf. 

Compass. Indicates the direction you are facing. The red dot always points north. The arrows on the 
base of the compass allow you to use Easy Move mode. Clicking on the compass itself gives you an 
indication of your character's condition and overall situation. 

Message Scroll. Displays messages and results of commands. 

Power Gem. In combat, rhe gem glows red, then yellow, then green, then sparkles as you put more 
power into an arrack. 

Current Spells. Icons represent active duration spells. 

Command Icons. Access rhe game option panel, and determine whether the right mouse-button 
allows you to Look, Get, Use, Fight or Talk. 

Gargoyle. Above the view window is a gargoyle. During combat, the glow in its eyes changes as the 
condition of your foe changes: 

Green eyes mean your foe is still strong. 

Yellow means the foe is hurt. 
Red means the foe is seriously injured. 
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MOVEMENT 
Walking, Running, Swimming. Press and hold the left mouse-button while the cursor is in the 3-D 
view window. The further from the center of the window your cursor is, the faster you move. The 
shape of the cursor determines direction: 

Move forward 

Turn right or left while moving forward 

Turn right or left with no forward movement 

Sidestep right or left 

Move backwards 

Jumping. Press the right mouse-button while the left button is down. (In fight mode, press [[!or 
!ISHIFTllQ] on your keyboard.) Your speed determines how far you jump: 

Standing still, you jump straight up. 

Walking or running, you jump in the direction of your movement; distance jumped increases 
with speed. 

Flying. Cast a Fly or Levitate spell, or use an appropriate magic item. Use [[! to rise into the air. Use 
the normal movement commands to determine your direction of flight. Use ~ to lower yourself. 

INTERACTING WITH THE WORLD 
Default Mode. If no icons are highlighted, you are in Default Mode. (To "un-select" a highlighted 
icon, click on it.) 

Talk. Put the cursor on the person or creature and briefly right-drag the mouse. 

Get. Position the cursor on the object, press and hold the right mouse-button. If the object is "get­
able," it will be put in-hand when you drag the object some-where on the screen. Release the button 
to drop the item. 

Look. Right-dick on the creature or item you want to examine. 

Fight. Move the cursor ro your inventory and click on the weapon in your weapon-hand. Click on 
the weapon again ro exit fight mode. 

Use. To use an object in your inventory, left-click it. To use an object in the view window, position 
the cursor on the object, and briefly right-drag it. 
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NOTE: To access the game options menu you must click on the Options icon or press the 
appropriate keys on the keyboard. 

Icon Mode. Use the right mouse-button to interact with things in the underworld. The command 
icons determine what the right button does. 

• 

• 

• 

Options Icon. Click on this to bring up a list of game-related functions and to pause the 
game. Click on the function you wish to access: 

Save Game . Preserves your current game state. You can have up to four saved games at once. Each 
saved game requires about 300K of hard disk space. Always save before ending a game session. 

R.estore Game. Begins the game ar a point you saved. Click on this option, then on the roman 
numeral that matches the name of the saved game. 

Mmic. Toggles music on or off 

So1111d. Toggles sound effects on or off. 

Detail. Increases or decreases the level of graphic detail. 

Return to Game. Resumes play when you're done selecting options. 

Q11it Game. Returns you to DOS. (This does not save the game.) 

Talk Icon. Left-click this icon, then right-dick the character you wane to talk to. 

Get Icon. Left-click this icon, then right-click the object you wane to pick up. 

Look Icon. Left-click this icon, then right-click the object or area you want to look at. 

Fight Icon. Left-click this icon. To attack, right-click and hold until you're ready to attack, 
then release the right button. 

Use Icon. Left-click this icon, then right-click the object you wane to use. For actions that 
require a target, left-click this icon, then right-dick the object you wish to use (putting it "in­
hand"). Move the object in-hand over the "target" object and right-click again. 

HEALING 
To regain lost Vitality (or shake off the effects of poison), you must eat and sleep, or cast healing magic. 

The healing spells are Lesser Heal, Heal and Greater Heal, in order of the Vitality they restore. 
These do not restore Mana. 

To regain Vitality and Mana, you must sleep. Press ~ or use a bedroll. When you awaken, you 
regain some percentage of lost Vitality and Mana. If you are hungry, sleep does less to revitalize you. 
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PAUSING THE GAME 
With a mouse, click on the Options Icon. This pauses the game and brings up a menu of options. To 
unpause, click on "Return to Game." On the keyboard, press [DJ to pause, IMI to unpause. 

MAGIC 
Magic requires three things: 

Mana. The Mana point cost of a spell is triple the Circle of the spell. 

Character Level. Your character level, halved and rounded up, must equal or exceed the Circle 
of the spell. 

Rune Stones. The rune stones required to cast each spell are listed below. 

Casting Spells. If the three conditions above are met, you can attempt to cast a spell. To do so, click 
on the runebag in your inventory, then click on each rune required to cast the spell, in order. When 
the runes appear on the rune shelf, left-click anywhere on the rune shelf. 

Targeting Spells. Some spells must be targeted. When you left-click the rune shelf to cast such a 
spell, a targeting cursor appears on screen. For combat spells, the targeting cursor is a red circle . For 
non-combat spells, the cursor is a blue cross. 

When a targeting cursor appears, position it on the person, creature or object you wish to target, 
then right-click to unleash the spell. (You may or may not succeed.) 
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The Eight Circles of Runic Magic 

Spell List 

First Circle Fifth Circle 
Create Food 'M~ Cure Poison 
Light 

'" Fireball 
Magic Arrow 

'' Missile Protection 
Resist Blows 11)1'1 Name Enchantment 
Stealth .,,. Open 

Second Circle Sixth Circle 
Cause Fear n Daylight 
Detect Monster NI"\ Gate Travel 
Lesser Heal ,~,, Greater Heal 
Rune of Warding 

" Paralyze 
Slow Fall ruff{ Telekinesis 

Third Circle Seventh Circle 
Conceal !S'1 I' Ally 
Lightning ~x Confusion 
Night Vision n Fly 
Speed R.ft( lnvisibiliry 
Strengthen Door "Tf Reveal 

Fourth Circle Eighrh Circle 
Heal 'M Flame Wind 
Levitate ~ Freeze Time 
Poison i-M Iron Flesh 
Remove Trap ~ Roaming Sight 
Resist Fire 

"'"' 
Tremor 
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COMBAT 
Using a Hand Weapon. 

1. Click on a weapon in your weapon hand (or on rhe Fight icon) to enter figh t mode. 

2. Position the cursor on your target. 

3. Hold down rhe right button until the weapon is drawn back (You can continue to move by 
pressing the left button while the right button is pressed .) 

4. With the weapon drawn back, the power gem begins to brighten, indicating how much power 
you are putting into the arrack. 

5. Release rhe mouse-button to attack. (If the gem is still red when you release the button, your 
attack is aborted .) 

Types of Attack. 
Bash. Press the right button when the cursor is high in the view window. 

Slash. Press the right button when the cursor is in the middle of the view window. 

Thrust. Press che right button when rhe cursor is low in the view window. 

Missile Weapons 
1. Ready a missile weapon by placing it in your hand on the Inventory panel. Make sure you have 

ammunition in your inventory. Enter fight mode. 

2 . Press and hold the right mouse-butron to initiate an attack (screen location doesn't matter). 

3. When che jewel is g reen, your weapon is ready to shoot and a red, circular cursor appears. 

4. Move the cursor where you want to aim your weapon. 

5. Release the mouse-button to unleash the attack. 

CONVERSATION 
To talk to a character or creature: 

1. 

2. 

Click on the Talk icon. 

Position the cursor over the character you wish to talk to, then press the right mouse-button to 
bring up the conversation screen. The other person's comments appear on the large scroll in 
the center of the screen. Your response options appear on your message scroll. 

25 



3. 

4. 

Move the yellow cross onto the option you want and click either button (or press the number 
of the statement you want to make). 

Read the other person's response and pick one of your own. If you see the word "[MORE}" at 
rhe end of a comment, click either mouse-button or press any key ro see the rest of what che 
other person has to say. If you see the word "Other" in your list of choices, you have the option 
of typing in something that isn't on your list. 

5. If you have the last word in the conversation, you return to the main game screen 
automatically. Otherwise, click either mouse-button or press any key. 

Bartering 
I. Select che option on your conversation option list chat says you want co trade items. 

2. Get items you are willing to trade and put rhem in your barter area. 

3. Click on items in either barter area co select or deselect chem for the current trade. 

4. Offer the deal by clicking on the appropriate menu line, or click on "] musr think about this 
deal" to use your appraise skill. 

5. If the person or creature with whom you are trading accepcs the deal, any items you offered 
disappear into your crading partner's inventory. Now, you may move traded items from his 
barter area into your inventory. 

6. If the deal isn't accepted, you can change the highlighted items in either barter area and try again. 

7. At the end of a bartering session, any items that now belong to you appear on the floor in front of you. 

Giving and Getting I tems 
1. Place the item you wish to give or show in your barter area. 

2. Select a conversation option like "I wish to give you this gift." The character takes the item 
from your barter area, or simply looks at it, depending on the circumstances. 

3. If a character gives you something, it appears on your cursor, allowing you co place it in your 
inventory. 

Repairing Items 
Some characters in rhe Abyss offer to repair items. To have a broken item repaired, place it in your 
barter area before you select the option requesting rhe repair. 
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To repair damaged weapons or armor yourself: 

1. Use an anvil as you would any item. 

2. When your cursor turns into an anvil, dick on the broken item. 

3. A message appears telling you how difficult the repair will be and asking if you want to 
continue. 

4. Select "Yes" or "No." 

KEYBOARD CONTROLS 
When using a keyboard, note that the game is case sensitive - ll SHIFT!l[M is not the same as [M. 
Also, there are some keyboard commands for which there are no mouse equivalents - even mouse 
users must use these. These commands are listed below in italics. 

Menus 
Up to next option above 
Down to next option below 
Left one column 
(2-column lists only) 
Right one column 
(2-column lists only) 
Top of List or 
Top of List 
Bottom of List or 
Bottom of List 
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Slide Right 
Walk Backwards 
Easy Move Backwards 

O ther Movement 
E Fly Up 

Fly Down 
Look Down 
Center View 
Look Up 
Standing Long Jump 
Jump 

Combat Mode Keys 

B 
Bash 
Slash 
Thrust 

Special Function Keys 

I 
Game Options/Pause Game 
Talk Mode 
Get Mode 



Game Oprions 

Rl ffi 
li CTRL ll~ 

Look Mode 
Fight Mode 
Use Mode 
Flip Character Panel 
Cast Spell 
Use Track Skill 
Sleep 

Save Game 
Restore Game 
Change Music 
Change Sound Effects 

Change Detail Level 
Return to Game 
Quit Game 

Cursor Movem ent Keys 
Move cursor one hot area right 

~ Move cursor one hot area left 

Numeric Pad 

~-m Cursor D irection 
Left Mouse-Button 
Right Mouse-Button 

Labyrinth of Worlds Reference Card 
BEGINNING PLAY 
l nsrall the game, following the directions above. Change to the CD -ROM drive and type [[[J~[IJ] 
II ENTER ! to begm play. If you used our default selections you would rype: 

IIIDD II ENTER I 
[[!~!ill [I ENTER ! 

The firsr rime you play, typing [[!~Kr! takes you to the tide screens, followed by the introduction. 
Press 100[ to bypass the tides and/or introduction and go to the Main Menu. 

If you have played (and saved) rhe game, typing [[J~[IJ] takes you to the ride screens and then the 
Mam Menu. 

MAIN MENU 
To select an option with the mouse, click on it. With the keyboard, use the arrow keys to highlight 
it, then press [I ENTER I to select it. 

Create Character. Choose before you begin a new game. Use the mouse or arrow keys and follow 
the dtrecttons on-screen to make selections. 

Introduction. Allows you to watch the introduction. (Press [00[ to exit at any time.) 

Acknowledgements. Lists the people who created ULTIMA Underworld II . 
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J ourney Onward . If you have saved games, a list appears when you select Journey Onward. Move 
the pointer to the game you wish to play and click either button. (With the keyboard, use the arrow 
keys to highlight your choice and press [I ENTER I[.) 

MAIN GAME SCREEN 
When you Journey Onward, the main game screen appears. 
3-D View Window. The view window shows what you see: 

As you move, the view changes to reflect your new position. 

When you take damage in combat, the window shakes. 

When you are critically wounded, the screen flashes red. 

When you are drowning, rhe screen flashes blue. 

When you wear or use a cursed item or a spell backfires, the screen flashes orange. 

Normally, you look srraight ahead, but you can look up and down: 

To look down, press !JJ repeatedly. 

To look up, press ~ repeatedly. 

To return to the "straight ahead" position, press m. 
Character Panel. Three panels share this position, and you can switch from one to the other at will. 

The inventory panel shows all items you are carrying and wearing. From the inventory panel: 

Left-click the runebag in your invent-ory to flip to the rune display. 

Click on the pull chain to flip to rhe statistics panel. 

Your rune display shows all of the runes you own. Click on the pull chain to rerurn to the 
inventory panel. 

The statis tics panel displays derailed information about your characrer's skills and current 
condition. Click on the pull chain to return co the inventory panel. 

On these panels, the right mouse-button triggers che action specified by the command icon 
selected and, when used co drag, moves an item; the left button selects or uses an object. 

Vitality and Mana Flasks. Shows your current Vitality or Mana as compared to your maximums. If 
the Vitality flask is green, you are poisoned. 

Rune Shelf. Click on runes in your rune display and they appear here. Click on a rune here to cast 
the spell represented by the runes on the shelf. 
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Compass. Indicates the direction you are facing. The silver arrow-tip always points north. Clicking 
on the compass irself gives you an indication of your character's condition and overall situation. 

Message Scroll. Displays messages and results of commands. 

Power Gem. In combat, the gem starts red, then turns green, then sparkles when the attack is at 
maximum power. 

Current Spells. Icons represent active duration spells. 

Command Icons. Accesses the game option panel, and determines whether the right mouse-button 
allows you ro Look, Get, Use, Fight or Talk. 

Gargoyle. Above the view window is a gargoyle. During combat, the glow in its eyes changes as the 
condition of your foe changes: 

Green eyes mean your foe is still strong. 

Yellow means the foe is hurt. 

• Red means the foe is seriously injured. 

MOVEMENT 
Walking, Running, Swimming. Press and hold the left mouse-butron while the cursor is in the 3-D 
view window. The further from the center of the window your cursor is, the faster you move. The 
shape of the cursor determines direction: 

1' Move forward 

... t"' ""' ,.., 
4111- .... 

Tum right or left while moving forward 

Tum right or left with no forward movement 

Sidestep right or left + Move backwards . 

Swift-moving water and slick ice may make movement difficult and may even cause you to move m 
a direction you didn't want to go! 
Jumping. Press the tight mouse-button while the left button is down. (In Fight mode, press !:LJ on 
your keyboard.) Your speed determines how far you jump: 

Standing still, you jump straight up. You jump forward if you press ~QJ 

Walking or running, you jump in the direction of your movement; distance jumped increases 
with speed. 

30 

Flying. Cast a Fly or Levitate spell, or use an appropriate magic item. Use I[! to rise inro the air. Use 
the normal movement commands to determine your direction of flight. Use I@! ro lower yourself 

INTERACTING WITH THE WORLD 
Quick Mode. If no icons are highlighted, you are in Quick Mode. (To "un-select" a highlighted icon, 
dick on it.) 

Talk. Pur rhe cursor on rhe person or creature and briefly right-drag the mouse. 

Get. Position rhe cursor on rhe object, press and hold rhe right mouse-button. If the object is "ger­
able," it will be put in-hand when you drag the object some- where on the screen. Release the 
button to drop the item. 

Look. Right-dick on the creature or item you want ro examine. 

Fight. Move rhe cursor to your inventory and click on the weapon in your weapon-hand. Click on 
the weapon again to exit Fight mode. 

Use. To Use an object in your inventory, left-click it. To Use an object in the view window, position 
rhe cursor on the object, and briefly right-drag it. 

NOTE: To access the game options menu you must click on the Options icon or press the 
appropriate keys on the keyboard. 

Icon Mode. Use the right mouse-butron ro interact with things in the world. The command icons 
determine what the right button does. 

Options Icon. Click on this to bring up a list of game-related functions and to pause the game . 
Click on the function you wish to access: 

Save Game . Preserves your current game state. You can have up to four saved game_s at once. Each. 
saved game requires about 500K of hard disk space. Always save before endmg a game session. 

Re.Itore Game . Begins the game at a point you saved. Click on this option, then on the roman numeral 
that matcbes the name of the saved game. 

M11Jic. Toggles music on or off. 

Sottnd. Toggles sound effects on or off. 

Detail. Increases or decreases rhe level of graphic detail. 

Rettlnz to Game . Resumes play when you're done selecting options. 

Q11it Ga1//e. Returns you to DOS. (This does nor save the game.) 
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Talk Icon. Left-click this icon, then right-click the character you want to talk to. 

Get Icon. Left-click this icon, then right-click and drag the object you want to pick up. 

Look Icon. Left-click this icon, then right-click the object or area you want to look at. 

Fight Icon. Left-click this icon. To attack, right-dick and hold until you're ready to attack, then 
release the right button. 

Use Icon. Left-click this icon, then right-click the object you want to Use. For actions that require a 
target, left-click this icon, then right-dick the object you wish to Use (putting it "in-hand"). Move 
the object in-hand over the "target" object and right-dick again . 

MAGIC 
Magic requires three things: 

Mana. The Mana point cost of a spell is triple the Circle of the spell. 

Character Level. Your character level, halved and rounded up, must equal or exceed the Grcle of the spell. 

Rune Stones. The rune stones required to cast each spell are listed below. 

Casting Spells . If the three conditions above are met, you can attempt to cast a spell. To do so, click 
on the runebag in your inventory, then click on each rune required to cast the spell, in order. When 
the runes appear on the rune shelf, left-click anywhere on the rune shelf 

Targeting Spells. Some spells must be targeted. When you left-click the rune shelf to cast such a 
spell, a targeting cursor appears on screen. For missile spells, the targeting cursor is a red circle. For 
non-missile spells, the cursor is a blue cross. 

When a targeting cursor appears, position it on the person, creature or object you wish to target, 
then right-dick to unleash the spell. (You may or may not succeed.) 

The Eight Circles of Runic Magic 
(see page 19) 

HEALING 
To regain lost Vitality (or shake off the effects of poison), you must eat and sleep, or cast healing 
magic. No healing magic restores Mana. The spells which restore Vitality are Lesser Heal, Heal and 
Greater Heal (in order of the amount of Vitality they restore). Cure Poison has no effect on Vitality, 
but reverses the effects of any toxins in your character's system. Restoration restores all Vitality, and 
it also negates poison, hunger, paralysis and fatigue. 
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To regain Vitality and Mana, you must sleep. Press ~ or Use a bed or a bedroll. When you 
awaken, you regain a percentage of lost Vitality and Mana. If you are hungry, or you have slept very 
recently, sleep does less to revitalize you. 

PAUSING THE GAME 
With a mouse, click on the Options Icon. This pauses the game and brings up a menu of options. To 
unpause, click on "Return to Game." On the keyboard, press 1§1 to pause and ~ again to unpause. 

THE AUTO-MAP 
Use the auto-map parchment to bring up a full-screen map. Your position is indicated by a small 
pushpin. Usually, the map updates itself automatically as you explore, but it is possible to get lost. 

Changing Views. Click either mouse-button on a facet of the gem on the right-hand side of the 
map to bring up an image of the world represented by that facet. Click on the castle in the center of 
the gem ro bring up the map of Lord British's castle. 

To view maps of different levels in a given world, click either mouse-button on the arrows in the 
upper- and lower-right corners of the map until the level you want is displayed. 

Notes. To write a note, move the quill-shaped cursor until it is pointing where you want your note 
to appear, click either mouse-button and begin typing. To end the note, click again, press l l ENTER ~ or 
press [M l· 
To erase a nore, move the cursor over the eraser, click either mouse-button, move the eraser over the 
note you want to erase and click either mouse-button. 

Exiting the map. To return to the game from the auto-map, click either mouse-button on the 
"Close" scroll or press [Ml-

COMBAT 

Using a Hand Weapon 
1. 

2. 

3. 

4. 

Click on a weapon in your weapon hand (or click on the Fight icon) to enter Fight mode. 

Position the mouse cursor in the view window to select an attack type. (See "Types of Attack," below.) 

Hold down the right button until the weapon is drawn back. (You can continue to move by 
pressing the left button while the right button is pressed.) 

With the weapon drawn back, the Power Gem begins to brighten, indicating how much power 
you are putting into the arcack. 
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5. Release the mouse-button to attack. (If the gem is still dark green when you release the 
button, your attack is aborted.) 

Types of Attack 

Bash. Press the right butcon at the beginning of each attack when the cursor is high in the view window. 

Slash. Press the right button when the cursor is in the middle of the view window. 

Thrust. Press the right button when rhe cursor is low in the view window. 

Missile Weap ons 

I. Ready a missile weapon by placing it in your hand on the inventory panel. Make sure you have 
ammunition in your inventory. Enter Fight mode. 

2 . 

3. 

4. 

5. 

Press and hold the right mouse-button to initiate an attack (screen location doesn't matter). 

When the jewel is green, your weapon is ready to shoot and a red, circular cursor appears . 

Move the cursor where you want to aim your weapon. 

Release the mouse-button to unleash che attack. 

CONVERSATION 
To talk to a character or creature: 

I. 

2. 

3. 

4. 

Click on rhe Talk icon. (In Quick Mode, skip this seep.) 

Position the cursor over the character you wish to talk to, then press the right mouse-button to 

bring up the conversation screen (or, in Quick Mode, position the cursor on the character, then 
right-dick and drag rhe mouse). The ocher person's comments appear on the large scroll in the 
center of the screen. Your response options appear on your message scroll. 

Move the mouse cursor onto the option you want and dick either button (or press the number 
of the statement you want to make). 

Read rhe other person's response and pick one of your own. If you see the word "(MORE]" at 
the end of a comment, click either mouse-button or press any key to see the rest of what the 
ocher person has co say. If you see the word "Ocher" in your list of choices, you have the option 
of typing in something chat isn't on your list. 

5. If you have the last word in the conversation, you return to the main game screen 
automatically. Otherwise, click either mouse-button or press any key. 
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Bartering 
1. Select the option on your conversation option list that says you want to trade items. 

2. 

3. 

4. 

5. 

6. 

Get items you are willing to trade and put them in your barter area. 

Click on items in either barter area to select or deselect them for the current trade. 

Offer the deal by clicking on rhe appropriate menu line, or click on "! muse chink about this 
deal" co use your appraise skill. 

If the person or creature with whom you are trading accepts the deal, any items you offered 
disappear into your trading partner's inventory. Now, you may move traded items from his 
barter area into your inventory. 

If che deal isn't accepted, you can change the highlighted items in either barter area and cry again. 

7. At the end of a bartering session, any items that remained in the barter area that belong to you 
appear on the floor in front of you. 

Giving and Getting Items 
1. Place the item you wish to give or show in your barter area. 

2. Select a conversation option like "I wish to give you this gift." The character takes the item 
from your barter area, or simply looks at it, depending on the circumstances. 

3. If a character gives you something, it appears on your cursor, allowing you to place it in 
your inventory. 

Repairing I tems 
To repair damaged weapons or armor: 

1. Use an anvil as you would any item. 

2. When your cursor turns into an anvil, click on the broken item. 

3. A message appears celling you how difficult rhe repair will be and asking if you want co 
continue. 

4 . Select "Yes" or "No." 
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KEYBOARD CONTROLS 
When using a keyboard, note that the game is case sensitive - llSHIFTi0 is not the same as 0· 
Also, there are some keyboard commands for which there are no mouse equivalents - even mouse 
users must use these. These commands are listed below in italics . 

Two of these keyboard-only commands require additional explanation: The H andedness command 
and the Save to .GIF command. 

Handedness. Some players find it easier to click-and-drag with the left mouse button than with the 
right. The game allows you to do this with the ~[[! command. Pressing ~[[! reverses the 
function of each mouse button. So, for example, you could press ~[[! and use the right mouse­
button to move. All functions normally associated with the right mouse-button would then be 
controlled by the left. 
Save to .GIF. Press~[£! to save any game screen (including your automap) as a .GIF fi.le. With 
appropriate software, you can then view saved screens whenever you wish . Many .GIF viewers and 
conversion programs are available as shareware and can be down.loaded from computer bulletin 
board systems. Note chat you cannot save introduction or endgame screens in this manner. 
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Menus 

m Up to next option above 

m Down to next option below 

[[3 Left one column (2-column lists 
only) 

[13 Right one column (2-column 
lists only) 

ll~t:J111 Top of List or 
Top of List 

llPG DN ! Bottom of List or 
IM I Bottom of List 

Normal Movement 
~ Run Forward 
0 Turn Left 
[IDJ Turn Right 
[Il Slide Left 
[£] Slide Right 
[0 Walk Backwards 

Other Movement 

[I] 
m 
rn 
[I! 
[£! 
[[! 
(ISHIFTIUJ 

Look Down 
Center View 
Look Up 
Fly Up 
Fly Down 
Jump 
Stancling Long Jump 

Combat Mode Keys 
l0J Bash 
i:;:JJ Slash 
Q Thrust 

~ecial Function Keys 
Fight Mode 

~ Use Mode 
[[gJ 
!Bl 
~ 
~ 
[lg 
~ 
~ 
~ 

Game Options 

~[[! 

Get Mode 
Talk Mode 
Look Mode 
Game Options/Pause Game 
Slide Character Panel 
Cast Spell 
Use Track Skill 
Sleep 

Reverse functions of left and 
right mouse buttons 
Save screen as .GIF file 
Change Detail Level 
Turn Sound Effects on/off 
Calibrate/center joystick 
Turn Music on/off 
Quit Game 
Restore Game 
Save Game 
Return to Game 

Cursor Movement Keys 
(in game and on auto-map) 
~ Move cursor one hot area right 
llSHIFT ll~ Move cursor one hot area left 

Numeric Pad 

m -rn 
[@:.! 
D 
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Cursor Direction 
Left Mouse-Button 
Right Mouse-Button 



Joystick CONTROLS 
In addition to mouse and keyboard control, you can play ULTIMA Underworld II with a joystick. 

Movement 
To move, push or pull the joystick in the direction you wish to go - push forward to move forward, 
pull back to move back, and so on. 

Your speed is determined by how far you push or pull the joystick. The farther you move the stick, 
the faster you move. 

(Note that you can't sidestep or jump when using the joystick - you must use the keyboard commands.) 

Selecting Options 
To control cursor movement (to select one of the game icons, for example), press joystick button #1 
and move the joystick. Moving the stick while button #1 is pressed moves the cursor, not your 
character. 

(Since buttons vary from joystick to joystick, a bit of experimentation may be necessary in order to 
determine which button is # l on your stick.) 

Actions normally accomplished with the right mouse-button are accomplished by selecting an icon, 
moving the cursor and pressing joystick button #2 when the cursor is over the person or object with 
which you want to interact. 

Some actions may require you to keep both joystick buttons pressed simultaneously. For example, to 
pick up and move an object from the view window into your inventory, you would first press button 
# l to move the cursor over the Get icon. Press button #2 to select this icon. Then press button # l 
again and move the cursor over the object you want to pick up. Now, press button #2 . while 
keeping button # l pressed to pick up and move the object. When it is over the appropriate circle in 
your inventory, release both buttons. The object will fall into place. 

NOTE: that you can combine joystick and keyboard controls to increase efficiency. (In the example 
above, you could simply press 3 to select Get mode, saving yourself time and effiirt.) 

In Brief 
To move: No button, move joystick. 
To control cursor: Button #1, move joystick 
To emulate right mouse-button: Button #2 
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Technical Support 
If, after thoroughly reviewing ALL the documentation, you are still having a problem 
with this software, please read the following section. 

Electronic Arts has a staff of customer service technicians ready to help you with any 
problems you may encounter with the game. Electronic Arts Customer Service is 
available Monday to Friday during normal business hours on (01753) 546465. 
Today's PCs run with millions of different hardware and software combinations. Because 
of chis, you may also have to refer to your computer dealer or hardware manufacturer in 
order to properly configure their product to run with our game. 

When you call, if at all possible, be near your computer. If ir is nor possible, make sure 
you have rhe following information ready: 
• The error message displayed when rhe" problem occurred (if any). 
• A listing of your machine type and hardware contents, including CPU, sound and 

video board details. 
• The DOS version number you are currently running. 
• Your mouse and driver type. 
• The contents of your CONFIG.SYS and AUTOEXEC.BAT files . 
• Your CD-ROM drive type and CD-ROM extensions version, if fitted. 
• The contents of a CHKDSK and MEM/C statement. 

Or you may write to us ar rhe following address , including the above information. 
Electronic Arrs Cusromer Service, P.O. Box 835 , Slough, Berkshire, England SL3 8XU 
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Notice 
ELECTRONIC ARTS RESERVES THE RIGHT TO MAKE IMPROVEMENTS IN THIS PRODUCT DESCRIBED IN THIS MANUAL AT 

ANY TIME AND WITHOUT NOTICE. 
THlS MANUAL, AND HIE SOFTWARE DESCRIBED IN THIS MANUAL, IS UNDER COPYRIGHT. ALL RIGHTS ARE RESERVED. NO 
PART OF THIS MANUAL OR THE DESCRIBED SOFTWARE MAY BE COPIED, REPRODUCED, TRANSLATED OR REDUCED TO 
ANY ELECTRONIC MEDIUM OR MACHINE-READABLE FORM WITHOUT THE PRIOR WRITTEN CONSENT OF ELECTRONIC 
ARTS LIMITED, 90 HERON DRIVE, SLOUGH, BERKS SLJ 8XU, ENGLAND. 
ELECTRONIC ARTS MAKES NO WARRANTIES, CONDITIONS OR REPRESENTATIONS EXPRES~ OR IMPLIED, WITH RESPECT 
TO THIS MANUAL, ITS QUALITY, MERCHANTABlLITY OR FITNESS FOR ANY PARTICULAR PURPOSE. THIS MANUAL IS 
PROVIDED "AS IS". ELECTRONIC ARTS MAKES CERTAIN LIMITED WARRANTIES WITH RESPECT TO THE SOFTWARE AND 
THE MEDIA FOR THE SOFTWARE. IN NO EVENT SHALL ELECTRONIC ARTS BE LIABLE FOR ANY SPECIAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES. 
THESE TERMS AND CONDITIONS DO NOT AFFECT OR PREJUDICE THE STATUTORY RIGHTS OF A PURCHASER IN ANY CASE 
WHERE A PURG!ASER IS A CONSUMER ACQUIRING GOODS OTHERWISE THAN IN THE COURSE OF A BUSINESS. 

Limited Warranty 
ELECTRONIC ARTS WARRANT~ TO THE ORIGINAL PURCHASER OF THIS COMPUTER SOFTWARE PRODUCT THAT THE 
RECORDING MEDIA ON WHIG! THE SOFTWARE PROGRAMS ARE RECORDED WILL BE FREE FROM DEFECTS IN MATERIALS 
AND WORKMANSMIP FOR 90 DAYS FROM THE DATE OF PURCMASE. DURING SUCH PERIOD DEFECTIVE MEDIA WILL BE 
REPLACED IF THE ORIGINAL PRODUCT 15 RETURNED TO ELECTRONIC ARTS AT THE ADDRESS ON THE REAR OF THIS 
DOCUMENT, TOGETHER WITH A DATED PROOF OF. PURCHASE, A STATEMENT DESCRIBING THE DEFECTS, THE FAUl:rY 
MEDIA AND YOUR RETURN ADDRESS. 
Tl-115 WARRANTY IS IN ADDITION TO, AND DOES NOT AFFECT YOUR STATUTORY RIGHTS IN ANY WAY. 
THlS WARRANTY DOES NOT APPLY TO TME SOFTWARE PROGRAM THEMSELVES, Wli lCH J\RE PROVIDED "AS IS", NOR DOES 
IT APPLY TO MEDIA Wl·llCH HAS BEEN SUBJECT TO MISUSE, DAMAGE OR EXCESSIVE WEAR 

© 1993 ORIGIN Systems, Inc. All rights reset·ved. ORIGIN, The Stygian J!byJJ, Ulti111a, Underzwrld, and \Ve malt WDrlds 
tlre regi1Jered trrulemari:J of OR1GTN Systems, Inc. Labyrinth of iVorlds is rt trademark of ORIGIN System11 Inc. Electronic 
ArtJ is rl registered tmdemark of Electronic Arts. LookingG!ass llchnologies is a tradem£trk of LookingG/ass Ttch11ologies. 
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